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Overview 
 
This software is used for the connecting to the FlexLink unique integrated motor units only. It 
can be used for downloading application software and adjusting parameters in order to 
change the behaviour of the units and monitoring the motor status. 
 
It was originally developed for the release of X45e platform in 2010 but is constantly updated 
for new features. It has been added a lot of communication option for the second generation 
of X45e units (Ethernet version), 
 

Hardware 
 
To be able to use this software you need a PC with following system requirements: 
  

- Windows 7 or 10 
- Minimum one USB connection (2.0) 

 
This software can communicate with FlexLink units in a number of different alternative. 
 
For the version of X45e units with CANbus there is a need for a special communication 
cable. This is a part of a FlexLink article called Parameter setting tool kit, 5113270. It 
consists of the following components: 
 

 - CAN to USB cable: Kvaser Leaf Light HS 
 - Adapter cable: FBA-CO-SUB-9-M12 

 
For the newer Ethernet version of X45e it is possible to connect to the unit with a standard 
mini-USB cable. 
 

- mini-USB cable 
 
The PST software also supports communication alternative on the line level (A-Bus or ETH). 
Still, it is recommended to start with the option to connect individually to each unit through 
the options mentioned above. 
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Software 
 
The latest version of the Parameter Setting Tool together with a range of other useful files 
(motor software and documentations) can be downloaded from www.flexlink.com. 
(MyFlexLink -> Download Area)  

Software Installation 
 
Follow this procedure to install the PST software: 
 

1. Copy and unzip the file PST.zip to the target computer.  
 

2. Run PST-x.y.z.exe as administrator in order to start the installation procedure. 
 

3. A pop-up windows appears stating which version of the software that is to be 
installed. Click Next > to continue.  

 

 
Picture: Installation – Welcome screen 

 
  

http://www.flexlink.com/
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4. The End-User License Agreement window has to be accepted. 
Then click Next >. 
 

 
Picture: Installation – End-User License Agreement 

 
5. Next you can create a desktop shortcut or not.  

Then click Next >. 
 

 
Picture: Installation – Create a desktop shortcut 
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6. Then the software is ready to install.  
Click Install. 
 

 
Picture: Installation – Ready to Install 
 
7. In the next step the actual installation is started. 

 

 
Picture: Installation – Installing Parameter Setting Tool 
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8. The next step is to choose additional installations if required. Kvaser CAN driver is 
only required if you want to use X45e units with CANbus. Win10Pcap is only required 
if you want to open connection via Profinet.  
Click Next > to continue. 
 
Note: The Kvaser driver installation could also be done from the CD included together 
with the communication cable or from the website www.kvaser.com 
 

 
Picture: Installation – additional installations 
 
9. Start of Kvase CAN driver installation. 

Click Next > to continue. 
 

 
Picture: Installation – Kvaser CAN Driver Setup 
 

  

http://www.kvaser.com/
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10. Kvaser CAN Drivers Setup – Release notes.  
Next step gives the possibility to read about the release notes and the installation 
instructions of the Kvaser software.  
Click Next > to continue. 
 

 
Picture: Installation – Kvaser, Release Notes 

 
11. Kvaser CAN Drivers Setup – Choose Components. 

Next window is for choosing the components to be installed. The default setting is ok 
to use. The start menu short cut can be unselected if wanted.  
Click Next > to continue. 
 

 
Picture: Installation – Kvaser, Choose Components 
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12. Kvaser CAN Drivers Setup – Choose Install Location. Next pop up window is for 
setting the destination folder for the Kvaser software. Change the default setting if 
required.  
Click on Install to continue. 
 

 
Picture: Installation – Kvaser, Choose Install Location  
 
13. When the installing is complete click Close to finish the Kvaser installation.  
 

 
Picture: Installation – Kvaser, Installation Complete 

 
When the Kvaser CAN cable is connected to a USB port the PC tries to recognise the 
hardware and install it automatically. Ever unique USB port is installed separately.  
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14. Start of Win10Pcap setup.  
Click Next to continue. 
 

 
Picture: Installation – Win10Pcap setup 
 
15. The End-User License Agreement window has to be accepted. 

Then click Next. 
 

 
Picture: Installation – Win10Pcap End-User license Agreement 
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16. The destination folder can be changed. 
Click Next to continue. 

 

 
Picture: Installation – Win10Pcap Destination Folder 
 
17. Then the software is ready to install.  

Click Install. 
 

 
Picture: Installation – Win10Pcap Ready to install 
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18. In the next step the actual installation is started. 
 

 
Picture: Installation – Installing Win10Pcap 

 
19. With next window the installation of Win10Pcap is completed. 

Click Finish to close the wizard. 
 

 
Picture: Installation – Installation completed 
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Graphic interface 
This is the graphical screen layout of the software. The four areas, panes, are described 
below. The menu structure is described in a separate chapter.  
 

 
Picture: Parameter Setting Tool Screen 
 

Network pane  
This area contains a progress bar used when scanning or verifying a network at the top.  
The rest of the pane is for showing all nodes on the network, the node list. This could be both 
nodes from a real network or an offline configuration. If all nodes are not fitted in the node list 
a horizontal scroll bar appears. There are two types of motors icons that can be in this list, 
the drive motor and the function motor.  
 

                             
 
Picture: Drive motor & Function motor 
 
Every node show the node number at the far left of the node box. The node has a node 
number even if no field bus is activated. The middle small icon is the status indicator. This is 
explained in detail later in this document where the Verify network command is covered 
(Network menu).The last small icon is the selection tick box. This is only for selecting the 
node before other commands are triggered.  
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Picture: Graphical node, node list 
 

Setting pane 
This pane is divided into several smaller setting windows. All information in this pane is 
correlated to the selected node in the network pane. The interaction with the node are 
described in the chapter regarding the Action menu. 
 

 
Picture: Settings pane 

Tool pane 
Next to the Setting pane is the Tool pane. This area is changing depending on which tool 
that is currently activated. It is also correlated to the selected node in the network pane. If no 
node is selected it could show a system picture if a configuration is open and a system 
picture is activated. 
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Action pane 
The bottom pane is the Action pane. This shows some command buttons from the Action 
menu. If a configuration is open it is also printing out the configuration name along with its 
folder structure. If the user is connected to a unit without working with a configuration the text 
Direct mode is visible (as the example below). 
The software can also show some addition user information below the button row.  
 

 
Picture: Action pane - example 
 
 

Operating modes 
The Parameter setting Tool software has two different operating modes. 

Configuration mode 
If the parameter settings are supposed to be stored in a file for later use a configuration must 
be used. This gives the possibility to set up a complete system of certain number of nodes 
offline. The Config column in the setting pane shows the configuration data. When the real 
equipment is installed these settings can be downloaded to the system node by node.  
 
See the Appendix for a description of two installation procedures 
 

Direct mode 
 
The direct mode is interacting with the connected motor or motors without a configuration. 
This mode is started with a Scan network command to detect all connected nodes. 
Then it is possible to read and write parameters, download new software, calibrate or monitor 
the motor. If wanted, it is also possible to switch to configuration mode by using the Save as 
command. 
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Menu structure 

File menu 
The File menu is used when operating with configuration files. These files are always in xml 
format. 

 
Picture: File menu 

New configuration… (Ctrl+shift+N) 

The New configuration… command creates an empty xml file. A pop up window appears 
demanding the user to type in the required configuration name (including the extension .xml) 
together with the target folder. 
 
 

 
Picture: New configuration… 

Open configuration… (Ctrl + O) 

This command opens an existing configuration file. After the command is triggered a pop up 
window “Choose configuration file” appears and the user has to browse and choose an 
xml file. The nodes in the configuration are visualized in the node list in the network pane. If 
the screen is too small for all motors fit a horizontal scroll bar appears. The folder path and 
the configuration name are printed in the Action pane. This command also activates the 
configuration mode.  



 

 

  

5113270-04  

  17 (54) 

Save configuration (Ctrl + S) 

The Save configuration command stores the values in the configuration into a configuration 
file, (.xml). The command is writing to the existing file name and path. If no configuration is 
open this command is greyed out.   
 
When working on the A-bus only nodes that has been explicitly read parameters from will be 
saved to the configuration file. 

Save configuration as… (Ctrl + shift + S) 

The Save configuration as command works similar as the Save configuration command. 
The only difference is that the user must specify the file name and the path. And the 
command is activating the configuration mode. 

Close configuration  

The Close configuration command closes the current configuration. The user has to either 
open a new configuration or scan the network. 

Export node 

This command saves the marked node to a separate configuration containing only this node. 
The user must specify the file name and the path. 

Import node  

The import command adds a node to the configuration. The user has to specify the address 
of the new node and the file name and the path of the motor configuration to be imported. 

Exit (Ctrl + Q) 

The software session ends with the command Exit. 
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Edit menu 
All commands under the edit menu are used for changing the currently open configuration. 

 
Picture: Edit menu 

New node (Ctrl + N) 

The new node command adds a node to the current configuration by opening a wizard pop 
up window. The user must choose which type of unit the added node should be set as. See 
separate chapter for a more detailed description of the wizard. 
 
If no configuration is open the user is required to open an existing configuration or create a 
new one. 

 
Picture: New node (if no configuration is open) 
 

Change node (Ctrl + E) 

The Change node command can be used for changing both the node address and the 
variant on the selected node. The first window is used for changing the node address of the 
selected node. The user can quit the command by clicking Only change address.  
 

 
Picture: Change node – Set address 
 
Otherwise the command continues by opening the wizard sequence giving the possibility to 
choose another variant setting for the selected node. See separate chapter for a more 
detailed description of the wizard. 
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Online /Offline change 
When the change node command is completed the new settings are always written into the 
Value column. If the selected unit is connected on the network (either via A-Bus or B-Bus) 
these new settings are also written down to the actual node (into the Network column). It is 
not automatically written into the configuration file (Config column). This has to be done 
explicitly with a Save command. If the new settings only was a temporary test the 
configuration settings could be used again with the Restore command. In this case the node 
address will not be changed back if it differs from the configuration.  

Move left (Ctrl + L) 

The nodes appear in the node list in the order they were created. The move left command 
takes the marked node and switches position with the node at left. The command is greyed 
out if no node exists to the left of the selected node. 

Move right (Ctrl + R) 

This command switches the marked node with the node at the right. The command is greyed 
out if no node exists to the right of the selected node. 

Delete node (Ctrl + D) 

The delete node command removes the marked node from the currently open configuration. 
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System picture 

The system picture is an option for the user to add a picture representing the complete 
configuration. This picture will be shown in the tool pane when graphics is chosen but node 
specific node is marked.  
 

 
Picture: System picture - example 
 
When the System picture… command is run it opens up a configure system picture window. 

 
Picture: Configure system picture 
 
Select picture… 
This command requires the user to select the system picture. The file must be located in the 
same folder as the configuration file. 
Allowed file formats:  

- .png 
- .gif 
- .jpg 
- .bmp 
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Clear picture 
The Clear picture command can be used to remove the connection between the 
configuration and the system picture. 
 
Cancel 
The configure system picture pop up window can be closed by selecting cancel. It is also 
possible to close this window with the close icon in the top right corner. 
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Network menu 
The Network menu is containing commands and settings useful when operating with the 
nodes. 

 
Picture: Network menu 
 
The PST software is compatible with both the old CAN-based X45e units as well as the 2nd 
generation of X45e units which supports Ethernet.  
 
When connecting with nodes the PST software needs to know how they are connected to the 
PC which PST are running on. These options are found under the X45e option and can be 
grouped into two sub categories. The first category is when the unit is connected directly to 
one unit. This is done with the B-Bus on the old X45e units and USB on the newer version. 
Then there is also the option to connect to the units through the line network. This is done 
with either CANopen or DeviceNet on the old version of X45e and Ethernet/IP or 
PROFINET on the newer version.   
 
See the User documentation, Electrical system description, 5113269 for more details 
around the A-Bus and B-Bus concept on the first generation of X45e units (CAN version). 
 
See the User documentation, Electrical system description, FLX1000558 for more 
details around the ETH and USB concept on the second generation of X45e units (Ethernet 
version). 
 

B-Bus (CANopen) 

The B-Bus connects directly to the motor via the internal bus. The parameter cable must be 
connected between the PC and the motor node (connection BUS B). The tool can only reach 
the connected motor. The internal bus in every motor node should always contain two nodes, 
FEG and ECO. In order to download the ECO software you have to use this alternative (for 
the CAN version of X45e). This communication option requires the Kvaser com cable.  

USB 

The USB connects directly to the motor using a standard mini-USB cable. The tool can only 
reach the connected motor. The internal bus in every motor node should always contain two 
nodes, FEG and ECO. In order to download the ECO software you have to use this 
alternative. This option is only possible with the Ethernet version of the X45e unit and 
requires a standard mini-USB cable. 



 

 

  

5113270-04  

  23 (54) 

A-Bus (CANopen) 

This alternative connects to the external bus (A-bus) with CANopen protocol. The external 
network links all motors units together. This option gives the possibility to communicate with 
all motors on the network. On a network there is a limit of one master or scanner module 
simultaneously. In normal running mode the line controller is the master on the network. 
When adding a PC running PST with the A-Bus setting activated it can be interfering the 
communication from and to the line controller. Because of this it is recommended to 
disconnect the line control (network master) on the network while working with the PST in A-
Bus mode. If the line controller is disconnected during the communication via the PST 
software it is important to keep the network supplied with power.  
 

Pin 2 =  + 24 VDC 
Pin 3 =  -  

Table: Pin configuration, A-Bus power 

A-Bus (DeviceNet) 

The A-Bus setting also exists in a DeviceNet version. There is no difference with this choice 
(compared to CANopen, above) except the field bus protocol. Additionally master node 
address and the state of PLC (enabled or not) has to be set in a dialog. If PLC is not enabled 
PST has to behave slightly different. X45e unit can be controlled by PST in this case. 
 

 
Picture: Master node address 

ETH (Ethernet/IP) 

The Ethernet version of X45e units has the possibility to connect via the ETH connectors. If 
this options is used several nodes can be connected to the same network. PST is then 
scanning the complete Ethernet network for X45e nodes. The connected nodes has to be set 
to Ethernet/IP in order to appear in the node list. When this option is selected the follow up 
question below shows in a pop up window. 
 

 
Picture: PLC enabled 
 
Without enabled PLC PST is able to control the X45e unit. 
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ETH (PROFINET) 

The ETH setting also exists in a PROFINET version. There is no difference with this choice 
and the Ethernet/IP except the communication protocol. PLC must always be disabled. 
 

 
Picture: PLC disabled 
 

Scan network (F12) 

The command Scan network searches the connected network for active nodes and replies 
by updating the node list in the network pane. This command is only executed in Direct 
mode. If a configuration is opened the user must answer the question: Leave 
configuration?  When executing the command the progress bar at the top indicates the 
scanning process together with the info text scan network in the action pane. After the 
command is completed the PST is always in Direct mode. If a scan network command has 
been performed without finding any nodes this is also stated in the info text: No nodes 
found. 
 
A-Bus / ETH 
If the network is set to A-Bus every motor node has one function controller showing its 
identity in the node list (in the network pane). 
  
B-Bus / USB 
If the network is set to B-Bus two nodes should appear. The function controller is called the 
FEG. The FEG controller is represented with the icon of either a function motor or a drive 
motor. This node address is by default 1 but could be changed by the user. The drive 
controller is called ECO and has always the node address 127. This B-Bus is the internal 
CANopen network that these two controllers are continuously communicating over. This 
internal communication has priority over the PST communication. Because of this the Scan 
network command could possible miss one or both nodes. In that case, repeat the 
command once again.  
 

 
Picture: Node list example, USB & function motor 
 
The status of the Scan network process is shown in the node list until the next time a Scan 
network is performed. This means a node can drop of the network and still be visible on the 
screen. When a scan is done a firmware check is also done. If the firmware on either the 
FEG or the ECO processor differs from the list of compatible version an error message 
window pops up. The list can be reached from the Help menu, About command.   
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Verify network (F11) 

The verify command is used for checking the network. It gives information about node 
numbers and motor types compared to the current setup in the node list. If a configuration is 
open and B-Bus / USB mode is used the found node is automatically selected. 
 

Colour:         

ETH / A-Bus,  
Configuration 
mode Not applicable 

Node is found 
Correct software 
version 

Node is found 
Motor type is 
incorrect or FEG 
or ECO version 
is old 

Node is not 
found or FEG 
version not 
supported 

ETH / A-Bus,  
Direct mode Not applicable 

Node is found 
Correct software 
version 

Node is found 
FEG or ECO 
version is old 

Node is found 
FEG version not 
supported 

USB / B-Bus,  
Configuration 
mode 

Node is not 
connected 

Node is found 
Correct software 
version 

Node is found 
Motor type is 
incorrect or FEG 
or ECO version 
is old 

Node is found 
FEG version not 
supported 

USB /B-Bus,  
Direct mode Not applicable 

Node is found 
Correct software 
version 

Node is found 
FEG or ECO 
version is old 

Node is found 
FEG version not 
supported 

 

 Old FEG version: more than 10 versions before latest version. 

 Not supported FEG version: version before oldest supported version. 

 Old ECO version: version before supported version.  
 
(see About dialog in Help menu for information regarding supported versions). 

 

Check Mac address 

If a 2nd generation X45e unit is connected then Check Mac address will also be available in 
Network menu. This will show you a small dialog with Mac address of connected X54e unit. 
 

 
Picture: Check Mac address 
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Action menu 

 
Picture: Action menu 
 
This menu contains commands interacting with a specific motor node. The picture below 
describes the data flow for the parameters. Note that the commands in this menu (action 
menu) are interacting between the PC level and the Motor node. The other commands 
(Save/Save as and Open) are interacting with the configuration file.  
 

 
Picture: Data flow, parameters  
 
See the User documentation, Electrical system description, 5113269 or FLX1000558 in 
order to find information about individual parameters. 
 

Read (from network) (F9) 

The Read (from network) command reads data from a specific motor node. The command 
can also be accessed via the Read button in the action pane (at the bottom of the screen). 
When the command is triggered all data in the Network column is deleted. The new data 
from the node are filled in in the Network settings. All these parameters are then copied to 
the Value column. All other data in the settings pane (Function group, Network settings and 
Control settings) are also updated together with the picture in the tools pane. Only data from 
the marked node is uploaded.  



 

 

  

5113270-04  

  27 (54) 

Write (to network)  

The Write (to network) command writes the data from the Value column to the selected 
node. After a write command is executed a Read command is automatically done (the 
downloaded parameter value should appear in the Network column after download). The 
command can also be accessed via a dedicated Write button in the action pane (at the 
bottom of the screen).  

Restore (configuration to value) 

When working in configuration mode it is always possible to change the Value column and 
write to the motor unit without updating the configuration file (with Save or Save as…). Then 
it might be useful to go back to the saved configuration setup of the unit. This is done with 
the Restore command. This command takes the currently open configuration and updates 
both the Config and the Value columns with its data. It is very similar to the Open 
configuration… command. The difference is that Restore keeps the Network column intact 
from the last Read command. Then it is easy to compare what has been changed since the 
last backup. Also the Restore command doesn’t restore the node addresses if these has 
been changed.    

Factory reset 

The factory reset command restores all values to default settings. This is different depending 
on the hardware. The main advantage with this command if the unit has been set to an 
invalid combination of parameters in the advanced mode and should be restored. After this 
command the user can continue to set the correct parameters either using the wizard or fine 
tune.  

Stop in boot loader 

If a 2nd generation X45e unit is connected via USB then Stop in boot loader will also be 
available in Action menu. This will guide you with a number of dialogs to stop the motor in 
boot loader instead of starting the firmware. Then you can make a firmware. That might be 
helpful if firmware is somehow defect and firmware update is not possible the normal way 
(via USB, Ethernet/IP or Profinet or web server of X45e). 
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Tools menu 

 
The tools menu is controlling what Tools to show in the tool pane. Activities is a sub menu 
which content depends on version and type of device and how it is connected. The Tools 
pane is always showing one of the options. The default setting is to show Graphics. 
 

 
Picture: Tools menu 

Graphics (Ctrl + G) 

If a node is marked in the node list a picture of this node is shown in the tool pane. There are 
mainly two categories of nodes, drive units and function units. The drive unit will only show a 
right or a left version. The function unit will be showing a more explanatory picture 
representing the behaviour of the unit. This picture is explaining the home position angle (to 
be used in calibration) and also all of the release and receive angles. 
 

 
Picture: Graphics – example (Combined divert/merge 90 right) 
 
When no node is selected and a configuration is open the system picture (if chosen) will be 
shown.    
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Monitor (Ctrl + M) 

The monitor screen is updated constantly until another tool option is activated.  
These view will be slightly different depending on which generation of X45e unit that is 
connected. 
 

 
 
Picture: Monitor (Function unit, 2nd generation) 
 
Received data 
The left part of the monitor screen is presenting data sent from the line controller to the X45e 
unit. It consists of two bytes of data (2x8 binary signals). The round indicator at the top of the 
received data window is flashing green when communication is detected. Examples of 
signals is digital outputs, enable and clear errors.  
 
Transmitted data 
The right part is presenting data sent out from the X45e unit to the line controller (or PST). It 
consists of four byte data (4*8 binary signals). The circle indicator at the top is flashing green 
when communication is detected (message available). Examples of signals are digital inputs, 
In position of the and alarms.  
 
All motors have an internal state handling in the software. These differ depending on the 
motor type. It is build up by three binary signals. The actual state is written next to the state 
bits. 
 
See the User documentation, Electrical system description, 5113269 or FLX1000558 in 
order to find more information about the available data. 
 
RUN TIME 
Accumulated time enable has been on, printed in format “Y years, D days, HH:MM:SS”. 
This value is stored in a permanent memory space inside the integrated motor node every 
hour. At power loss the run time since last write event is lost. The reason behind this solution 
is that the permanent memory area has a limit number of write events. 
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POWER 
Momentary power drawn by the motor, stated in W. This value is only shown for a conveyor 
motor. 
 
CYCLE COUNT 
Accumulated number of cycles completed by the unit. This value is stored in a permanent 
memory space every hour. At power loss the cycle count since last write event is lost. This is 
because the permanent memory area has a limit number of write events. 
This value is only presented for a function motor. 
 
LAST SEQUENCE 
This is a time value (in ms) for the last executed sequence. The sequence is timed from start 
of one cycle to the start of the next cycle, meaning it also includes any idle time between the 
cycles.   
 
FEG SW 
Software version in the FEG controller (processor). 
 
ECO SW 
Software version in the ECO controller (processor). 
 
TEMPERATURE 
Every motor has an analog sensor for measuring the temperature on the PCB board.  
 
Flash diodes (button) 
This button trigger the node to flash with green colour with both LED’s. 
This can be useful to quickly check which of the nodes that has the selected address in an A-
bus network. The button has a toggle function. 
 
Show inputs (button) 
The show inputs function visualizes the status of the digital inputs on the two LED’s. 
This can be useful at a start-up or at trouble shooting on the node (including the sensors). 

 DI1 – LED 1 green (same side as DI1&DI3) 

 DI2 – LED 2 green (same side as DI2&DI4) 

 DI3 – LED 1 red (same side as DI1&DI3) 

 DI4 – LED 2 red (same side as DI2&DI4) 
The button has a toggle function. 
 
Reboot (button) 
This command shuts down the node and start it up again immediately after. 
The LED’s are flashing green during the start-up. The text “Rebooting, wait 5 s…” is also 
printed in the action pane. When the unit is up and running the text disappears and the LED’s 
is lit green with fixed light.    
 
Clear errors (button) 
The command clear errors resets any existing faults. The node is then trying to start up once 
more.  
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Activities – Firmware update  

The Parameter Setting Tool software can be used for downloading firmware to both the drive 
controller ECO and the function controller FEG. For the FEG processor it is also possible to 
download new boot software. The Firmware update page can be reached from the Tools / 
Activities menu, via the Firmware update command.  
 

 
Picture: Firmware update 
 
FEG SW 
The user can specify the appropriate file to be downloaded. This firmware file is to be 
downloaded to the FEG processor. This processor contains the application software of the 
unit. This field should also be use when downloading new boot to the FEG processor. The 
name of this firmware has the following format:  
 
- feg_vXXX.mot (first generation unit) 
- feg_Vx.y.z.ihex (2nd generation unit) 
 
 
ECO SW 
The ECO SW can also be specified if the user wants to download this file. This firmware 
exists in two versions, one for the drive motor and one for the function motor 
These are the names of the ECO files:  
 
- A_STEP_A_XXmot – Function motor (stepper motor) 
- A_PM_A_XX.mot – Drive motor (Permanent magnetic motor) 
 
To reduce the risk of downloading the wrong ECO SW-file to the unit there is a name filter 
when the user should select the firmware to download. The ECO SW can only be 
downloaded if the user is connected via the B-Bus or USB.  
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During the downloading of the software there is a feedback from the LEDs on the (first 
generation) motor. 
 

 Function motor LED colour Interval 

1 Downloading FEG SW green/red fast flashing 

2 Downloading ECO SW green fast flashing 

3 Rebooting green slow flashing 

4 Running (no A-Bus) green fixed 

Table: Feedback from the LED 
 
Start update (button) 
The firmware update process is started with the Start update button. 
 
Node progress 
This progress bar is presenting the complete download process. The node in progress 
number presents the actual node ID updated. This feature is only important when updating 
several units on the A-Bus or network.   
 
Programming progress 
This progress bar is showing the download process for the current node.  
 
When the downloading process is completed a feedback text describing if the downloading 
succeeded or not is shown on the download screen. 
 

 
Picture: Firmware update completed 
 
Bootloader Information 
In the firmware update page there is a command for reading the boot software version from 
the (first generation) unit. When the button Bootloader Information is pressed.  
 

 
Picture: Boot software version 
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Activities – Bootloader update 

First generation units have the possibility to update bootloader. This panel looks almost the 
same as Firmware update and it is same procedure. When the bootloader is downloaded 
the units has to be powered off and on again to activate it. This should be done at least five 
seconds after the bootloader is downloaded.  
 

Activities – Calibration  

All stepper motors have to be calibrated in order to determine a zero position. The 
Calibration screen can be reached from the menu Tools.       

           
Picture: Calibration process active / inactive 
 
Enable calibration / Disable calibration (button)  
When the text on the button is Enable calibration the calibration process is not started. As 
soon as the user starts the calibration presses the button the text changes to Disable 
calibration. The indicator next to the button turns to green when the calibration process is 
activated. 
 
Angle 
The text and the angle value are greyed out if the calibration process is inactive. To change 
the calibration angle the user could either right a new value in the Angle input field or 
increasing/decreasing the value with the arrow buttons.  
 
To get the info how the calibration reference (homing angle) it is showed either in the picture 
in the graphics screen or in the User documentation, 5113196  
 
Set Home position 
When the guide disc is correctly orientated it is possible to store this setting with the button 
Set home position. 
 
If the unit has been set with proper parameters and has been calibrated it should work 
according to the specification. It is still possible to adjust the angles to fine tune the function. 
The recommendation is to adjust the angles values in this case. 
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Activities – Logging  

The X45e units have a built in logging function that can be useful when wanting to trouble 
shoot and understand details about the behaviour of the unit. The logging function is sending 
out messages from the motor node on the internal bus. This means the B-Bus for first 
generation of X45e and USB for the 2nd. This requires the parameter cable (Kvaser cable) 
alternatively a standard mini-USB to be attached.  
 
See User documentation, Electrical system description, 5113269 or FLX1000558 for 
available logging signals 
 
 
Logging procedure (example) 

- Connect the B-Bus connector on the X45e unit to a PC via the parameter cable 
(Kvaser cable and the adapter cable). 

- Supply the X45e unit with 24VDC power on the PWR connector  
- Launch the Parameter Setting Tool software 
- Set the Network to X45e > B-Bus (CANopen)  
- Search for the X45e unit with Network / Scan network (F12) 
- Select the FEG node by clicking in the select tick box on the node with the motor 

icon. 
- Go to the Logging page from the Tools menu 
- Set all logging signals and log file (details are described below) 
- Start the logging with the start button. 
- Let the logging continue until a stop condition is triggered or stop it with the Stop 

button. 
- As an output the Log table are filled with log data. Also the file could be imported into 

excel for further analysis. 
 

 
Picture: Logging screen 
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Binary log signals 
All selected binary log signal will be logged. They will be logged at all transitions. To select 
more than one signal keep the CTRL key pressed while selecting all signals. The binary 
signals are only logged if some of them change status. 
 
Delayed start logging 
These signals defines when the actual logging to the txt file (and to the log table) should 
start. If more than one signal is selected it is enough that only one of the conditions are 
fulfilled. When a delay start signal is selected it appears in the window next to the signal list. 
Here it is possible to select more details about how the delay should be triggered. The option 
for every signal is:  
 

 Active – If the signal is true 

 Inactive – If the signal is false  

 Raising edge – If the signal goes from true to false 

 Falling edge – If the signal goes from false to true  

 Transition – If the signal changes 
 
If no signal is selected the logging starts immediately after the user pushes the start button. 
 

 
Picture: Delayed start logging 
 
Analog log signals 
This list contains all analog signal possible to log. The logging of the analog signals is event 
triggered on change.  
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Stop logging 
If some special signal/signals should be used for ending the logging this is specified here. In 
the same manner as for the delayed start the stopping of the logging could be specified more 
in details. The option for every signal is:  
 

 Active – If the signal is true 

 Inactive – If the signal is false  

 Raising edge – If the signal goes from true to false 

 Falling edge – If the signal goes from false to true  

 Transition – If the signal changes 
 

 
Picture: Stop logging 
 
Log file 
All log data are written to a txt file (tab separated data). File path and name are specified 
here. If an old file is used the browse button can be used to select it. File size is limited to 
100MB. A rollover algorithm limits the number of files to 5. 
 
START LOGGING / STOP LOGGING 
When the log screen is first launched the text on the button is START LOGGING. Then when 
this button is pressed it is possible to capture the other events. This doesn’t mean that the 
actual logging start only that the software starts to listen for events (triggers for delay start). 
When the logging events is started the text on the button changes to STOP LOGGING. The 
user can the stop the logging before the other stop condition is fulfilled. 
 
Reset selection 
The Reset selection button is removing all signal selections in the logging page.  
 
Duration 
If the check box next to Duration is selected the logging will only continue for a limited 
amount of seconds. This limit is specified in the Duration input field. 
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Calibrate Time 
It is recommended to run a calibration procedure every time a logging should be performed 
(first generation unit). Every individual Kvaser cable is a bit unique and has to be 
synchronized with the PST tool. These settings are not remembered by the software so it is 
needed to perform this calibration every time the logging page is opened. When the button is 
pressed the window below appears for some seconds. When this window disappears the 
calibration process is completed.  
 

 
Picture: Calibrate Time window 
 
Log table 
In this table window all the data from the logging are shown. This is also written to the txt file. 
The logging events are triggered on any change of either a binary or an analog log signal. 
Then all selected log signals will be stored. 
 
Import to Microsoft Excel 
The output file from the logging can be imported into Microsoft Excel using the command 
“Get Data From Text” and further used for creating charts. 
 

 
Picture: Logging graph – example 
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Activities – Control 

If PST is connected to X45e unit via DeviceNet, Profinet or Ethernet/IP then it is possible to 
control X45e unit like from a PLC. No active PLC must be connected to X45e unit at this 
time. 
 

 
Picture: Activities – Control 
 
This panel is quite similar to Monitor. Main difference is that the lights for Received data are 
buttons. State of these buttons is send to X45e unit frequently as if it came from a PLC. 
 

Activities – Health check 

2nd generation X45e unit supports a health check to see if everything is working. This check 
consist of 5 steps. 

 
Picture: Activities - Health check 
 
After clicking Run health check lights should get green one after the other. If a light get read 
then this step of health check has failed. Light keeps white as long as this step is not 
performed. 
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Activities – System logging 

If PST is connected to X45e unit via USB then it is possible to log system messages. Several 
interesting events causing log messages e.g. connecting/disconnecting Ethernet cable or 
requests to web server. 
 

 
Picture: Activities – System logging 
 
Log file can be set but is not required. After clicking START LOGGING every log message 
will appear in Log pane. 
 

Activities – Lua file handling 

If PST is connected to X45e unit via USB then it is possible to handle Lua files on X45e unit. 
 

 
Picture: Activities – Lua file handling 
 
Additional to a list of available files at X45e unit there are buttons for typical file handling 
operations. Current default file (which will be executed if unit is in Lua mode) is printed in 
bold. 
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Activities – Lua editor 

2nd generation X45e units can run Lua scripts for non-standard usage. For easy editing and 
testing of these scripts PST is hosting a single page application that will start in default 
browser when clicking Lua editor in Tools / Activities menu. 
 

 
Picture: Activities – Lua editor 
 
 
In the upper part of editor you find a tool bar with all functions and the IP address of currently 
connected X45e unit. First two buttons are to connect and disconnect from unit defined by IP 
address on right hand side. Next 5 buttons are for file handling (e.g. save, copy …). Then 
came search and replace. Last 3 Buttons are for setting default script and run and stop 
current script. 
Left hand side is a list of available files at X45e unit. Current default script (which will be 
executed if unit is in Lua mode) is marked with ‘>’. 
Editing area is main part of page. Below this is a logging area with events regarding 
connection to X45e unit. Command con.print() will result in messages here. 
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Activities – Change Lua password 

Access to Lua scripts at 2nd generation X45e units can have password protection. To set, 
change or remove the password at an X45e unit just click Change Lua Password in Tools / 
Activities menu. 
 

 
Picture: Activities Change Lua password 
 
If currently no password is set then the field for the old password is disabled. To remove the 
password just let field for new password blank. 
 

Advanced (Ctrl + A) 

The advanced option is not for normal use.  
The only reason for the user to use this option is if a control variant is wanted but there is no 
support of this in the wizard. In this case the user can adjust the following parameters: 
  

- Function mode 
- Function parameters 1-4 
- A-Bus enable drive and reset 
- A-Bus network protocol 
- Function group  

 
A detailed description of these settings can be found in appendix F.  
 
 
When Function variant is set the other parameters above are automatically set to the 
corresponding values (same as in the wizard).  
 

- Function Variant 
 
If this parameter is set to zero the other parameters are not changed. This could be used if a 
user defined parameter setting is to be used. This User defined set up is also possible to set 
via the wizard. 
 
The new setting is written into column Value and then transferred to the node with the Write 
button. 
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Options menu 

 
The Options menu is containing settings for the Parameter Setting Tool software. The only 
feature in the current version is the Language setting. 
 

 
Picture: Options menu 
 
 

Language 

 
The Language option has two alternatives: 
 

- English 
- Deutsch 

 
This affects all text fields in the software. 
When a new setting has been set the Parameter Setting Tool must be restarted. 
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Help menu 

 
The Help menu contains features that could be useful assisting the user when trouble 
shooting or learning more about the software.    
 

 
Picture: Help menu 

About 

With the About command in the Help menu it is possible to read out useful information 
regarding the version handling.   
 

 
Picture: About window 
 
PST version 
The PST version shows the actual version of the Parameter Setting Tool software and 
contains of three numbers.  
 

 The first is the major release version.  

 The second number is the sub version of the release. This is increased if a change is 
done in the definition of the PST software. This could be caused by a change in any 
of the motor software (FEG, ECO PM or ECO stepper). This could also be caused by 
a change or addition of some motor parameter. 

 The third number is the minor version. This is only concerning a small change in the 
PST software. No new motor software is released and no parameter setting is 
changed. 
 

FEG version 



 

 

  

5113270-04  

  44 (54) 

The FEG version describes the corresponding version of the FEG software. This is the valid 
range of versions that are compatible with the current version of the PST software. 
 
ECO PM version 
The ECO PM version describes the corresponding version of the ECO PM software. This is 
the valid range of version that is compatible with the existing version of the PST software. 
 
ECO Stepper version 
The ECO Stepper version describes the corresponding version of the ECO Stepper software. 
This is the valid range of version that is compatible with the existing version of the PST 
software. 
 

Release notes 

When new releases are developed it could be useful to read about the implemented 
changes. This can be read in the document opened by the command Release notes. 

Report issue 

The Report issue command launces an email client with the FlexLink software support email 
address as default.   
 
FlexLink software support email address: softwaresupport@flexlink.com 

Manual 

This command opens up a copy of this document. It is built in in the PST software and 
makes sure the user always has this help available when using the PST tool. 
 



 

 

  

5113270-04  

  45 (54) 

Wizard  
The wizard helps the user to set the motor node parameters step by step. It is initiated by the 
commands New node… or Change node….  
 

New node…/Change node… 
The first pop up window is describing which mechanical product (function/module) the 
particular motor node belongs to. If the software can detect what type the current motor is all 
other alternatives are greyed out. Throughout the complete wizard only valid combinations 
are possible to select, the other ones are greyed out. 
 

 
Picture: New node… or Change node…  
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Network settings 
The next step in the wizard is to set the network settings.  
 

 
Picture: Network settings (Wizard) 
 
There are five alternatives for the A-Bus protocol. For the two last options this bus is called 
Network protocol instead. 
 

- None  
This inactivates all A-bus features. The unit will not be able to communicate with a 
line controller at all. 

 
- CANopen – 250 kbit/s 

The node is prepared to communicate via CANopen protocol on the A-bus. With this 
option an interval (in ms) must be specified. This sets how often the cyclic information 
should be sent over the bus. 
 

- DeviceNet – 250 kbit/s 
The node is prepared to communicate with DeviceNet protocol on the A-bus. 
 

- Ethernet/IP  
The node is prepared to communicate with Ethernet/IP protocol on the ETH network. 
 

- PROFINET 
The node is prepared to communicate with PROFINET protocol on the ETH network. 

 
For 2nd generation X45e units Interval is replaced by IP address. 
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Control settings 
The last pop up window in the wizard is the control settings window.  
 

 
Picture: Control settings 
 

Enable-Reset 
Every motor has an enable and a reset signal. These could be set either from a line 
controller or internally. 
 
Autonomous 
If the Autonomous mode is chosen those two signals are set via this software. The enable 
bit is by default set to true (one) and the reset bit is set to false (zero). This means the motor 
is always trying to run when powered up. If a fault occurs the power has to be dropped in 
order to reset the error.  
 
Line control 
In the Line control mode those two signals has to be sent from a line controller via the A-
Bus network. This setting requires the Network setting to be set to either CANopen or 
DeviceNet. 

Control 

The control alternative decides the main control approach for the unit.  
 
Autonomous 
In autonomous mode all inputs to the unit comes from sensors connected directly to the unit. 
No interaction is done with a line controller. 
 
Line control 
In the Line control mode the unit interacts with the line controller to perform its task. This 
control mode is still depending on the local sensors but the main commands are coming from 
the line controller. This setting requires the Network setting to be set to either CANopen or 
DeviceNet. 
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Variant 

In some cases the Control mode can be divided into more sub categories. The variant is a 
more detailed option of the control selection.  
 
No choice 
If the Control doesn’t have any sub categories the option No choice is the only possible 
option to choose.  
 
1/1 
This choice is only implemented for the diverters. It means one product is diverted to the left 
and the next one is diverted to the right and so on. 
 
Sensor 
This choice is indicating that the unit triggers its behaviour by a sensor. It is not the ordinary 
sensor functions detecting the puck in the gap of the guide disc that is referred to. Typically 
this is used for locating units when the pucks should be released. Also there is a diverter 
variant that controls where to divert the pucks, depending on the sensor input. 
 
Inverted sensor 
The Inverted sensor selection is also triggered by sensors, but the function is inverted 
compared to the selection above. 
 
Normally closed 
The Normally closed mode is referring to the position of the guide disc of the function unit. 
This means when the function unit is in position to start a new cycle it waits in a position 
where it is not receiving any new pucks.  
 
Normally open 
On the contrary (compared to the selection above) the guide disc waits in a position where it 
is able to receive products. 
 
Timer 
If the Timer is set as the variant the trigger for the release movement is controlled by an 
internal timer. It is only applicable for locating units. 
 

Interlock 

Interlock is a function for temporary stopping the unit (pausing) depending on specified 
conditions. The setting window has two delays related to this interlock function. Not all 
function has the possibility to interlock. The reason for this is that digital input 4 is already 
used for other purposes.  
 
None 
No interlock functionality is activated. 
 
Normally closed 
Digital input 4 (DI4) is controlling the interlock function. The default condition of the input 
status is closed, i.e. the input is logical high. When it falls the unit is stopped temporary. 
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Normally open 
Digital input 4 (DI4) is controlling the interlock function. The default condition of the input 
status is open, i.e. the input is logical low. When it rises the unit is stopped temporary. 

IP settings 
If Ethernet/IP or PROFINET is chosen in an earlier step the IP setting pop up window 
appears. There are two main options, Dynamic or Fix Address. Dynamic addressing 
requires the network to have a DHCP server. 
 
 

 
Picture: IP settings 
 

Result 
When the wizard is completed the node list is updated to match the new setup. If the wizard 
has been triggered by the New node… command the node list is added with one more node. 
If the Change node… has been used the existing node is adjusted to the new settings. The 
symbol of the node is either a drive motor or a function motor depending on the actual motor 
type. 
 
See separate document describing all the variants and the behaviour:  
User documentation, Electrical system description, 5113269 or FLX1000558 
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Settings 
The setting values can be change and fine-tuned whenever wanted later on. It is only the 
parameters in the settings window that can be changed. When changing these parameters 
the user can key in the required value in the middle column (Value) and then use the Write 
button to download it to the unit. The function group, network settings or control settings are 
read-only. If these should be changed this has to be done with using the wizard (Change 
node…) or from the Advanced page. 
 

 
Picture: Settings - example 
 
See the User documentation, Electrical system description, 5113269 or FLX1000558 in 
order to find information about individual parameters. 
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Appendix 

A: Configuration example of start up, A-bus (X45e first generation) 
 

Offline preparation 

 

 Create an empty configuration 
 

 Use the wizard to add with appropriate number of nodes with correct settings and 
addresses. 

 

 Chose a system picture if wanted 
 

 Save the configuration to an xml-file 
 

Online, B-Bus 

 
All motors are set to address 1 at delivery. This has to be changed via the B-bus before 
continuing with other settings. 
 

 Connect Parameter Setting Tool cable to the first node via the B-bus 
 

 Chose Network -> X45e -> B-Bus (CANopen)  
 

 Chose Network -> Scan network (F12) to connect to the node. Two nodes should 
appear in the node list. If the configuration was open a question pops up asking if this 
configuration could be closed. 

 

 Chose Action -> Change address (Direct mode) and set the motor node to correct 
address 

 

 Repeat this procedure for all motor nodes 
 

Online, A-Bus 

 

 Make sure the A-Bus is connected properly, with bus terminations and that the bus is 
supplied by power. 

 

 Set the PLC in paus/stop mode or disconnect it from the network. This is a 
recommended action because it can cause problems if there are more than one 
master on the network and PST act like one.  

 

 Connect Parameter Setting Tool cable to the A-Bus 
 

 Open the configuration file 
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 Chose Network -> Verify network (F11) to detect status of the nodes. 
 

 Select the first node and download the parameters with the Write button. 
 

 Repeat the previous task for all nodes 
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B: Configuration example of start up, B-bus (X45e first generation) 
 

Offline preparation 

 

 Create an empty configuration 
 

 Use the wizard to add with appropriate number of nodes with correct settings and 
addresses. 

 

 Chose a system picture if wanted 
 

 Save the configuration to an xml-file 
 

Online, B-Bus 

 
All motors are set to address 1 at delivery. This has to be changed via the B-bus before 
continuing with other settings. 
 

 Connect Parameter Setting Tool cable to the first node via the B-bus 
 

 Chose Network -> X45e -> B-Bus (CANopen)  
 

 Chose Network -> Scan network (F12) to connect to the node. Two nodes should 
appear in the node list. If the configuration was open a question pops up asking if this 
configuration could be closed. 

 

 Chose Action -> Change address (Direct mode) and set the motor node to correct 
address 

 

 Chose File -> Open configuration… to reopen the created configuration 
 

 Chose Network -> Verify network to select the currently connected node 
 

 Press the Write button the transfer all settings to the node. 
 

 Fine tune any settings in the Settings window if needed 
 

 Repeat this procedure for all motor nodes 
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C: Upgrade of a function or drive motor in Direct mode (X45e first 
generation) 
 
 

 Use the old Parameter Setting Tool to connect to the motor and backup the 
parameters. This is not necessary but in case the unit has been fine-tuned is it 
recommended to store this values for further use. 

 

 Connect the parameter setting cable to the USB port at the PC and the B-Bus at the 
motor unit.  

 

 Launch the new Parameter Setting Tool software 
 

 Chose Network -> X45e -> B-bus (CANopen) 
 

 Chose Network -> Scan network (F12) to connect to the node.  
Two nodes should appear in the node list.  

 

 Mark the first node, represented by a symbol of the motor. This node is called FEG.  
 

 Chose Tools -> Activities to open the Firmware download page. Browse and select 
the latest FEG SW and ECO SW files. It is very important to update both software. 

 

 Start the firmware update procedure by pressing the Start update button. 
 

 Wait for the update to be finalized. 
 

 Chose Edit -> Change node… (CTRL + E) to start the wizard and set all setting to 
wanted values. When the wizard is completed all parameters are automatically 
downloaded to the motor node. One downside with this procedure (wizard function) is 
that any old change in the parameters is overwritten. The alternative is to use the 
advanced mode and set every individual parameter manually. But this requires a lot 
deeper knowledge about the parameters settings.  

 

 If necessary the Value column should be filled with any setting that needs to be 
adjusted. Download these settings by pressing the Write button in the action pane. 
Note that these setting appear under the Network column after the write procedure. 

 

 
 

 


